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Getting started

What is MST3K Animated Taskbar

The MST3K Animated Taskbar is based upon the popular Comedy Central show
Mystery Science 3000 which places two wisecracking robots CROOOOW T.
ROBOT and TOM SERVO and their human friend (Joel Robison and later Mike
Nelson) into a theater and forced to watch extremely cheesy movies.

The MST3K Taskbar places the boys on your Windows95 desktop. Adding to part
of your working environment just like the start button. The Bots and Mike/Joel are
their to wisecrack throughout your day. They are completely animated so you get

the full effect of the popular show right on your windows95 desktop.

What’s new

Well, first of all, the name is new. Because the way it works is new, we changed
the name to MST3K Animated Taskbar.

The Animated Taskbar merges two previous products: The MST3K Animated
Desktop and MST3K Sound Sucker. Which makes it easier than every to add your
own sounds into to your setup.

Instead of drawing directly to the Windows95 desktop we placed the bots into their
very own special taskbar. Drawing on the Windows Desktop just doesn’t seem to
be the way to do things in windows95. Having a taskbar is much more flexible in
the new environment and shouldn’t be effected by other programs like the
Animated Desktop was.

Like the Windows95 taskbar (aka the start button) The MST3K Animated Taskbar
sits at the bottom of the windows95 screen.

Right clicking on the taskbar brings up a properties menu, which allows you to
change the way the taskbar works. It also allows you to bring up the MST3K
Sound Sucker.
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Sound Sucker is a configuration editor. It allows you the add new sounds and
animate them. Sound Sucker also supports multiple configurations for the taskbar,
which means you could have several different groups of sounds and switch between
them. You could have a setup for each day of the week. To make the taskbar use a
different sound configuration, you’ll load that INI file into an make it your default.

You now have a choice to play the sounds randomly (which also will not play the
same sound two times in a row) OR you can play them sequentially.

Combining the sequential order with multiple configuration will help develop your
own separate sound file to share with others. Also, when you receive sounds from
others just place them in a new directory

Also, there is new sounds. Out of Laziness I downloaded sounds off the internet
and animated them. Also, I still don’t get comedy central so no MST3K - no new
sounds. I encourage everyone to visit the ftp site where I got the sounds:
ftp://clover.cleaf.com/, and I hope I do not make anyone mad by “stealing” their
sounds. I used them to help get recognition for the fip site and (as I said) laziness.

An Icon is added to the Windows95 Taskbar. Pointing the mouse over the icon
will display the next sound that will get played.

Installation and running the program

Sorry no slick and easy install program here. What do you want for nothing? It
should be pretty easy to set this program up yourself. Just simply unzip the
program into its own folder/sub-directory. Run the SUCKER32.EXE Program. Or
added a shortcut to it. That’s it.
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Menus and dialogs

The Taskbar context menu

The Taskbar context menu comes up when you right click on the MST3K
Aniamted Taskbar.

Menu Item Action

Sound Sucker Displays / Hides the sounds sucker sound configuration
editor,.

Animated Task Bar Displays / Hides the MST3K Animated Task Bar.

Properties... Brings up the taskbar properties dialog box.

Exit Closes both Sound Sucker and the Animated Taskbar.

The properties dialog

The Taskbar Properties dialog allows you to change the way the Animated Taskbar
works.
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Properties
Taszk bar |
— Play order
[ Sound " Fandom
¥ Sequential
Size — Time
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Cancel | [ Help

Sound

The sound checkbox turns sound on or off. You need a sound card to hear sound.

Size

Allows you to select the size of the Animated Taskbar..

Small - About the size of the windows taskbar.

Large - Twice the size of small.

Super Size - four times the size of small. About the same size as they appear on

the show.

Play Order

Random - play sounds randomly.

Sequential - Start with the first sound and play them in order. Repeating after all

sounds are played.

Time

Select the delay between sounds. Set the count and check the Minutes for the delay
to be minutes. Uncheck the minutes to set the delay to be seconds.
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Sound Sucker menus

The File Menu

The file menu has commands to create, open and save files.

Menu Item Action

New Create a new configuration file.

Open... Brings up the file open dialog box.

Save Save the current file.

Save As... Save the current file as a different name.

Make Current

Makes the current file the configuration for the MST3K
Animated Taskbar. It will reset and use the sounds
from this file now and in the future until another file is
made current.

Exit

Closes both Sound Sucker and the Animated Taskbar.

The Edit Menu

The edit menu allows you to copy sounds from one file to another.

Menu Item Action

Cut Copy the current selection to the clipboard and remove
it.

Copy._ Copy the current selection to the clipboard.

Paste Paste the sounds on the clipboard into this document.

Properties... Brings up the properties dialog.

The View menu

Allows you to display or hide items from view.

Menu Item Action
Toolbar Display / Hides the Sound Sucker Toolbar
Status Bar Display / Hide the sound sucker takerbar.

Sound Sucker

Displays / Hides the sounds sucker sound configuration
editor,.

Animated Task Bar

Displays / Hides the MST3K Animated Task Bar.
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Sound Sucker Files

Each Sound Sucker has three panes visible. The Sounds Pane, The Exit Sounds
Pane and The Demo pain.
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The Demo Pane

This displays the boys and animates them based on the animation specified when
you hit the test button in the Sounds Pane.

The Sounds Pane

The Sounds pane allows you to add new WAV files to the play list. The file sound
be copied into the same directory as the configuration file then hit the Add button
and select the file. All sound files for a give configuration file MUST BE in the
same directory as the configuration file. Remove lets you remove a file from the
play list. It does not delete the WAV file. Test will play the file and display the
animation in the Demo window.

The sound pane also has an animation grouping. When you select a sound in the
list of sounds the animation sequences for that sound are displayed in this grouping.

You can add new, remove or update animation sequences using the buttons. You
can select the time and characters to animated using the other controls. Set the
time in milliseconds and character and hit Add to add a new animation sequence.
Select a Animation sequence, change its settings to update. Select an animation
sequence and hit remove to delete it.

Hit thje test button to see your animation in the demo pane.
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The Exit Sounds Pane

The Exit Sounds pane allows you to add sounds that get played when you reset or
close the taskbar. This is a good place to put sound of “The Mads”. Like Sounds,
Add, Remove and Test work the same. Also, the WAV files need to be in the same
directory.
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Keys to Animating Sounds

Adding sounds and animation

The hardest thing about adding sounds is animating them. This is because there is
now good way to know who is talking, when. This is left up to the person adding
the sound. A good sound editor allows you to select parts of a sound so you can
select part of a sound to determine the length of time to animate.

You’ll need to figure out who talks and when. You can do this by playing the
sound over an over again taken notes on who to animate and for how long. You
can use Sound Recorder using the scroll bar to pause an play the sound and certain
points. Note what times sounds are occuring and for how long. Note who is
talking or laughing.
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This task can be greatly reduced by using a program such as Microsoft’s Quick
Record (shown above) that come with MS-Sound System. Or Creative Labs Wave
Studio that comes with most sound blasters. These programs allow you to select
parts of a sound(see below). You can play just the selected portion until you’ve
isolated the portion your interested in. And the tell you how long that selection is.
For example you can select the part in the sound where only Crooow is talking.
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You should break the sound up so you know who talks and for how long, from
begining to end. Be sure to also keep track of silence or part were no one is
talking. The table below is a example on how you might take note on this.
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Animate Time Time Cumulative
Sec Millsecs time

Crooow 2.3 2300 2.3

Nobody 1.3 1300 3.6

Joel 3.6 3600 7.2

Tom 1.2 1200 8.4

Crooow, Tom 1 1000 9.7

(laughing)

Joel 1.1 1100 10.8

I know this is a pain, but it takes human interaction to determine who is talking.
And most sound bites are quick and only one character speaks, so those are easy.

Now take your table and use Sound Sucker to add the animation sequences.

Add the sound using the add button. Then add each of the Animation sequences.
Select the Characters and put in the time in Milliseconds and hit the add button.

MSK3K
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Keep those disks moving

Once again .... IT'S FREE!!!!!!
How can I do it? Give this incredible software out for FREE, absolutely nothing.

® [ can share with people I have something in common with, a love for
a very creative program, Comedy Centeral’s Mystery Science
Theater 3000.

® ]learned a lot by writing this program so, I gain from it.

* [ enjoy hearing from people that like/dislike my work. So, please
eMail and send any video tapes. (thanks to all that did for
Mystery Science Animated Desktop!)

e [ STILL Don’t get Comedy Central so its all the MST3K I get!
(Unless you send me videos!!!)

Please send items to:

Doug Reichard

IMI Software

4177 West 224Th Street
Fairview Park OH 44126 USA

eMail:

Compuserve: 71640,1356
MSN: Doug Reichard

Internet: 71640.1356(@compuserve.com
Doug_Reichard@MSN.COM
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Copyright 1995 IMI Software.

This program was written for fun not profit. Any infringement on Trademarks or Copyrights is purely unintentional.
This program was written to help increase the popularity of one of the greatest television programs all time. Feel free
to distribute following the rules specified below.

This program is Freeware. But, please don’t let that stop you from sending me what you feel its worth!

Mystery Science Theater 3000 Animated Taskbar was written for use in the Microsoft® Windows95™ operating
environment .

The program (including its waveform audio and documentation files) is freeware. As such, it is not intended for sale,
resale, purchase, or for-profit distribution in the shareware or retail marketplace. The Source code is NOT in the
public domain and is therefore unavailable.

Users are welcome to copy and re-distribute the program files in any manner, provided that the files are kept in their
original state and format, and have not been altered, edited, disassembled, or recompiled in any way.

If you use this program just once drop me a line on Compuserve (my CIS address is 71640,1356). Please Please
Please Tell me what you think. Send comments and contributions to:

IMI Software
4177 West 224Th Street
Fairview Park OH 44126 USA

Mystery Science Theater 3000 Animated Taskbar is hereby contributed "as is" to the public domain. None of the
included files are intended for sale, purchase, or for-profit distribution.

"Microsoft" and "Windows95" are registered trademarks of Microsoft Corporation.
All other trademarks mentioned herein are trademarks or registered trademarks
of their respective corporations, and are hereby acknowledged.
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